TABLE OF CONTENTS

1  Introduction .........................................................................................................1 - 1
2  Getting started ...................................................................................................2 - 1
   2.1 Installation .....................................................................................................2 - 1
   2.2 General modelling aspects ...........................................................................2 - 1
   2.3 Input procedures ..........................................................................................2 - 3
      2.3.1 Input of geometry objects ....................................................................2 - 3
      2.3.2 Input of text and values ......................................................................2 - 3
      2.3.3 Input of selections ..............................................................................2 - 4
      2.3.4 Structured input .................................................................................2 - 5
   2.4 Starting the program .....................................................................................2 - 6
      2.4.1 General settings ...................................................................................2 - 6
      2.4.2 Creating a geometry model ...............................................................2 - 8
3  Settlement of circular footing on sand (Lesson 1) ...........................................3 - 1
   3.1 Geometry ......................................................................................................3 - 1
   3.2 Rigid footing ................................................................................................3 - 2
      3.2.1 Creating the input ...............................................................................3 - 2
      3.2.2 Performing calculations .....................................................................3 - 14
      3.2.3 Viewing output results ......................................................................3 - 18
   3.3 Flexible footing ............................................................................................3 - 21
4  Submerged construction of an excavation (Lesson 2) ......................................4 - 1
   4.1 Geometry ......................................................................................................4 - 2
   4.2 Calculations ..................................................................................................4 - 11
   4.3 Viewing output results ................................................................................4 - 14
5  Undrained river embankment (Lesson 3) ..........................................................5 - 1
   5.1 Geometry model ..........................................................................................5 - 1
   5.2 Calculations ..................................................................................................5 - 4
   5.3 Output ...........................................................................................................5 - 9
6  Dry excavation using a tie back wall (Lesson 4) ..................................................6 - 1
   6.1 Input ..............................................................................................................6 - 1
   6.2 Calculations ..................................................................................................6 - 5
   6.3 Output ...........................................................................................................6 - 9
7  Construction of a road embankment (Lesson 5) .................................................7 - 1
   7.1 Input ..............................................................................................................7 - 1
   7.2 Calculations ..................................................................................................7 - 4
   7.3 Output ...........................................................................................................7 - 5
   7.4 Safety analysis .............................................................................................7 - 7
8 Construction of a shield tunnel (Lesson 4) ....................................................... 8-1
8.1 Geometry ....................................................................................................... 8-2
8.2 Calculations ................................................................................................... 8-6
8.3 Output ........................................................................................................... 8-7
A Appendix A - Menu tree ................................................................................... A-1
A.1 Input menu ................................................................................................... A-1
A.2 Calculations menu ......................................................................................... A-2
A.3 Output menu ................................................................................................. A-3
A.4 Curves menu ................................................................................................ A-4
B Appendix B - Calculation scheme for initial stresses
due to soil weight ................................................................................................. B-1
3 SETTLEMENT OF CIRCULAR FOOTING ON SAND  (LESSON 1)

In the previous chapter some general aspects and basic features of the PLAXIS program were presented. In this chapter a first application is considered, namely the settlement of a circular foundation footing on sand. This is the first step to become familiar with the practical use of the program. The general procedures for the creation of a geometry model, the generation of a finite element model, the execution of a finite element calculation and the evaluation of the output results are described here in detail. The information provided in this chapter will be utilised in the later lessons. Therefore, it is important to complete this first lesson before attempting any further tutorial examples.

3.1 GEOMETRY

A circular footing with a radius of 1.0 m is placed on a sand layer of 4.0 m thickness as shown in Fig. 3.1. Under the sand layer there is a stiff rock layer which extends to a large depth. The purpose of the exercise is to use PLAXIS to find the displacements and stresses in the soil caused by the applied load. Calculations are performed for both rigid and flexible footings. The geometry of the finite element model for these two situations is similar. In the model the rock layer is not taken into account; instead an appropriate boundary condition is applied at the bottom of the sand layer. In order to avoid the prevention of any possible mechanism in the sand and to avoid any influence of the outer boundary, the model is extended in horizontal direction to a total radius of 5.0 m.
3.2 RIGID FOOTING

In the first calculation the footing is considered to be very stiff and rough. In order to carry out this calculation the settlement of the footing is simulated by means of a uniform indentation at the top of the sand layer instead of modelling the footing itself. This approach leads to a very simple model and is therefore used as a first exercise, but it also has some disadvantages. For example, it does not give any information about the structural forces in the footing. The second part of this lesson deals with an external load on a flexible footing, which is a more advanced modelling approach.

3.2.1 CREATING THE INPUT

Start PLAXIS by double-clicking the icon of the Input program. A Create/Open project dialog box will appear in which you can select an existing project or create a new one. Choose a New project and click on the <OK> button. Now the General settings window appears, consisting of the two tab sheets Project and Dimensions (see Figs. 3.3 and 3.4).

![Create/Open project dialog box](image)

Figure 3.2 Create/Open project dialog box

**General Settings**

The first step in every analysis is to set the basic parameters of the finite element model. This is done in the General settings window. These settings include the description of the problem, the type of analysis, the basic type of elements, the basic units and the size of the draw area. In order to enter the appropriate settings for the footing calculation follow these steps:

- In the Project tab sheet, enter “Lesson 1” in the Title box and type “Settlements of a circular footing” in the Comments box.
• In the General box the type of the analysis (Model) and the basic element type (Elements) are specified. Since this lesson concerns a circular footing, choose Axisymmetry from the Model combo box and select 15-node from the Elements combo box.

![General settings window](image)

Figure 3.3 Project tab sheet of the General settings window

• The Acceleration box indicates a fixed gravity angle of $-90^\circ$, which is in the vertical direction (downward). In addition to the normal gravity, independent acceleration components may be entered for pseudo-dynamic analyses. Leave these values zero and click on the <Next> button below the tab sheets or click on the Dimensions tab.

• In the Dimensions tab sheet, keep the default units in the Units box (Unit of Length = m; Unit of Force = kN; Unit of Time = day).

• In the Geometry dimensions box the size of the required draw area must be entered. When entering the upper and lower coordinate values of the geometry to be created, PLAXIS will add a small margin so that the geometry will fit well within the draw area. Enter 0.0, 5.0, 0.0 and 4.0 in the Left, Right, Bottom and Top edit boxes respectively.

• The Grid box contains values to set the grid spacing. The grid provides a matrix of dots on the screen that can be used as reference points. It may also be used for snapping to regular points during the creation of the geometry. The distance between the dots is determined by the Spacing value. The spacing of snapping
points can be further divided into smaller intervals by the *Number of intervals* value. Enter 1.0 for the spacing and 1 for the intervals.

- Click on the <OK> button to confirm the settings. Now the draw area appears in which the geometry model can be drawn.

![Figure 3.4 Dimensions tab sheet of the General settings window](image)

**Hint:** In the case of a mistake or for any other reason that the general settings need to be changed, you can access the *General settings* window by selecting the *General settings* option from the *File* menu.

**Geometry Contour**

Once the general settings have been completed, the draw area appears with an indication of the origin and direction of the system of axes. The x-axis is pointing to the right and the y-axis is pointing upward. A geometry can be created anywhere within the draw area. To create objects, you can either use the buttons from the toolbar or the options from the *Geometry* menu. For a new project, the *Geometry line* button is already active. Otherwise this option can be selected from the first button block with geometry objects in the toolbar or from the *Geometry* menu. In order to construct the contour of the proposed geometry, follow these steps:

- Select the *Geometry line* option (already pre-selected).
• Position the cursor (now appearing as a pen) at the origin of the axes. Check that the units in the status bar read 0.0 x 0.0 and click the left mouse button once. The first geometry point (number 0) has now been created.
• Move along the x-axis to position (5.0; 0.0). Click the left mouse button to generate the second point (number 1). At the same time the first geometry line is created from point 0 to point 1.
• Move upward to position (5.0; 4.0) and click again.
• Move to the left to position (0.0; 4.0) and click again.
• Finally, move back to the origin (0.0; 0.0) and click the left mouse button again. Since the latter point already exists, no new point is created, but only an additional geometry line is created from point 3 to point 0. PLAXIS will also detect a cluster (area that is fully enclosed by geometry lines) and will give it a light colour.
• Click the right mouse button to stop drawing.

Hints:
Mispositioned points and lines can be modified or deleted by first choosing the Selection button from the toolbar. To move a point or line, select the point or the line and drag it to the desired position. To delete a point or a line, select the point or the line and press the <Delete> button on the keyboard.

Unwanted drawing operations can be removed by pressing the Undo button from the toolbar or by selecting the Undo option from the Edit menu or by pressing <Ctrl><Z> on the keyboard.

Lines can be drawn perfectly horizontal or vertical by holding down the <Shift> key on the keyboard while moving the cursor.

The proposed geometry does not include beams, hinges, geotextiles, interfaces, anchors or tunnels. Hence, you can skip the remaining buttons of the first button block in the toolbar.

Hint: The full geometry model has to be completed before a finite element mesh can be generated. This means that boundary conditions and model parameters must be entered and applied to the geometry model first.

Boundary Conditions
Boundary conditions can be found in the second block of the toolbar and in the Loads menu. For deformation problems two types of boundary conditions exist:
Prescribed displacements and prescribed forces (loads). In principle, all boundaries must have one boundary condition in each direction. That is to say, when no explicit boundary condition is given to a certain boundary (a free boundary), the natural condition applies, which is a prescribed force equal to zero and a free displacement.

In order to avoid the situation where the displacements of the geometry are undetermined, some points of the geometry must have prescribed displacements. The simplest form of a prescribed displacement is a fixity (zero displacement), but non-zero prescribed displacements may also be given. In this problem the settlement of the rigid footing is simulated by means of non-zero prescribed displacements at the top of the sand layer.

To create the boundary conditions for this lesson, follow these steps:

- Click on the **Standard fixities** button on the toolbar or choose the **Standard fixities** option from the **Loads** menu to set the standard boundary conditions.
As a result PLAXIS will generate a full fixity at the base of the geometry and roller conditions at the vertical sides \((u_x=0; u_y=\text{free})\). A fixity in a certain direction appears on the screen as two parallel lines perpendicular to the fixed direction. Hence, roller supports appear as two vertical parallel lines and full fixity appears as cross-hatched lines.

**Hint:** The *Standard fixities* option is suitable for most geotechnical applications. It is a fast and convenient way to input standard boundary conditions.

- Select the *Prescribed displacements* button from the toolbar or select the corresponding option from the *Loads* menu.
- Move the cursor to point \((0.0; 4.0)\) and click the left mouse button.
- Move along the upper geometry line to point \((1.0; 4.0)\) and click the left mouse button again.
- Click the right button to stop drawing.

In addition to the new point (4), a prescribed downwards displacement of 1 unit (1.0 m) in a vertical direction and a fixed horizontal displacement is created at the top of the geometry. Prescribed displacements appear as a series of arrows starting from the original position of the geometry and pointing in the direction of movement.

**Hint:** The input value of a prescribed displacement may be changed by first clicking on the *Selection* button and then double-clicking on the line at which a prescribed displacement is applied. On selecting *Prescribed displacements* from the *Select* dialog box, a new window will appear in which the changes can be made. The value of the prescribed displacement that is actually applied in the calculation is controlled by a multiplier. This multiplier is set when defining a calculation (see 3.2.2).

**Material data sets**

In order to simulate the behaviour of the soil, a suitable soil model and appropriate material parameters must be assigned to the geometry. In PLAXIS, soil properties are collected in material data sets and the various data sets are stored in a material database. From the database, a data set can be appointed to one or more clusters. For structures (like walls, plates, anchors, geotextiles, etc.) the system is similar, but different types of structure have different parameters and therefore different types of data sets.
PLAXIS distinguishes between material data sets for *Soil & Interfaces, Beams, Anchors* and *Geotextiles*.

The creation of material data sets is generally done after the input of boundary conditions. Before the mesh is generated, all material data sets should have been defined and all clusters and structures must have an appropriate data set assigned to them.

**Table 3.1 Material properties of the sand layer**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td><em>Model</em></td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td><em>Type</em></td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Dry soil weight</td>
<td>$γ_{dry}$</td>
<td>17.0</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Wet soil weight</td>
<td>$γ_{wet}$</td>
<td>20.0</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Permeability in horizontal direction</td>
<td>$k_x$</td>
<td>1.0</td>
<td>m/day</td>
</tr>
<tr>
<td>Permeability in vertical direction</td>
<td>$k_y$</td>
<td>1.0</td>
<td>m/day</td>
</tr>
<tr>
<td>Young's modulus (constant)</td>
<td>$E_{ref}$</td>
<td>13000</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$ν$</td>
<td>0.3</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion (constant)</td>
<td>$c_{ref}$</td>
<td>1.0</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$ϕ$</td>
<td>31.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$ψ$</td>
<td>0.0</td>
<td>°</td>
</tr>
</tbody>
</table>

The input of material data sets can be selected by means of the *Material Sets* button on the toolbar or from the options available in the *Materials* menu.

To create a material set for the sand layer, follow these steps:

- Select the *Material Sets* button on the toolbar.
- Click on the <New> button at the lower side of the *Material Sets* window. A new dialog box will appear with three tab sheets: *General, Parameters* and *Interfaces* (see Figs. 3.6 and 3.7).
- In the *Material Set* box of the *General* tab sheet, write “Sand” in the *Identification* box.
- Select *Mohr-Coulomb* from the *Material model* combo box and *Drained* from the *Material type* combo box (default parameters).
- Enter the proper values in the *Weight* box and the *Permeability* box according to the material properties listed in table 3.1.
- Click on the <Next> button or click on the *Parameters* tab to proceed with the input of model parameters. The parameters appearing on the *Parameters* tab sheet depend on the selected material model (in this case the Mohr-Coulomb model).
See the Material Models manual for a detailed description of different soil models and their corresponding parameters.

Figure 3.6  *General* tab sheet of the soil and interface data set window

Figure 3.7  *Parameters* tab sheet of the soil and interface data set window
• Enter the model parameters of table 3.1 in the corresponding edit boxes of the Parameters tab sheet.
• Since the geometry model does not include interfaces, the third tab sheet can be skipped. Click on the <OK> button to confirm the input of the current material data set. Now the created data set will appear in the tree view of the Material Sets window.
• Drag the data set “Sand” from the Material Sets window (select it and keep the left mouse button down while moving) to the soil cluster in the draw area and drop it there (release the left mouse button). Notice that the cursor changes shape to indicate whether or not it is possible to drop the data set. Correct assignment of a data set to a cluster is indicated by a change in colour of the cluster.
• Click on the <OK> button in the Material Sets window to close the database.

**Hint:** PLAXIS distinguishes between a project database and a global database of material sets. Data sets may be exchanged from one project to another using the global database. The data sets of all lessons in this Tutorial Manual are stored in the global database during the installation of the program. In order to copy an existing data set, click on the <Global> button of the Material Sets window. Drag the appropriate data set (in this case “Lesson 1 sand”) from the tree view of the global database to the project database and drop it there. Now the global data set is available for the current project. Similarly, data sets created in the project database may be dragged and dropped in the global database.

**Hints:** Existing data sets may be changed by opening the material sets window, selecting the data set to be changed from the tree view and clicking on the <Edit> button. As an alternative, the material sets window can be opened by double clicking a cluster and clicking on the <Change> button behind the Material set box in the properties window. A data set can now be assigned to the corresponding cluster by selecting it from the project database tree view and clicking on the <Apply> button.

> The program performs a consistency check on the material parameters and will give a warning message in the case of a detected inconsistency in the data.
Mesh Generation

When the geometry model is complete, the finite element model (or mesh) can be generated. PLAXIS allows for a fully automatic mesh generation procedure, in which the geometry is divided into elements of the basic element type and compatible structural elements, if applicable. The mesh generation takes full account of the position of points and lines in the geometry model, so that the exact position of layers, loads and structures is accounted for in the finite element mesh. The generation process is based on a robust triangulation principle that searches for optimised triangles and which results in an unstructured mesh. Unstructured meshes are not formed from regular patterns of elements. The numerical performance of these meshes, however, is usually better than structured meshes with regular arrays of elements. In addition to the mesh generation itself, a transformation of input data (properties, boundary conditions, material sets, etc.) from the geometry model (points, lines and clusters) to the finite element mesh (elements, nodes and stress points) is made.

![Figure 3.8 Axisymmetric finite element mesh of the geometry around the footing](image)

In order to generate the mesh, follow these steps:

- Click on the *Generate mesh* button in the toolbar or select the *Generate* option from the *Mesh* menu.
After the generation of the mesh a new window is opened (Output window) in which the generated mesh is presented (see Fig. 3.8).

- Click on the <Update> button to return to the geometry input mode.

If necessary, the mesh can be optimised by performing global or local refinements. Mesh refinements are considered in some of the other lessons. Here it is suggested that the current finite element mesh is accepted.

**Hints:**

- By default, the *Global coarseness* of the mesh is set to *Coarse*, which is adequate as a first approach in most cases. The *Global coarseness* setting can be changed in the *Mesh* menu. In additional options are available to refine the mesh globally or locally.
- At this stage of input it is still possible to modify parts of the geometry or to add geometry objects. If modifications are made at this stage, than the finite element mesh has to be regenerated.

### Initial Conditions

Once the mesh has been generated, the finite element model is complete. Before starting the calculations, however, the initial conditions must be generated. In general, the initial conditions comprise the initial groundwater conditions, the initial geometry configuration and the initial effective stress state. The sand layer in the current footing project is dry, so there is no need to enter groundwater conditions. The analysis does, however, require the generation of initial effective stresses by means of the *K₀-procedure*.

The initial conditions are entered in separate modes of the Input program. In order to generate the initial conditions properly, follow these steps:

- **Initial conditions** Click on the *Initial conditions* button on the toolbar or select the *Initial conditions* option from the *Initial* menu.
- First a small window appears showing the default value of the unit weight of water, which is 10 (kN/m³). Click <OK> to accept the default value, after which the groundwater conditions mode appears. Note that the toolbar and the background of the geometry has changed compared to the geometry input mode.

The initial conditions option consists of two different modes: The water pressures mode and the geometry configuration mode. Switching between these two modes is done by the ‘switch’ in the toolbar.
Since the current project does not involve water pressures, proceed to the geometry configuration mode by clicking on the right hand side of the 'switch' (Initial stresses and geometry configuration).

- Click on the Generate initial stresses button (red crosses) in the toolbar or select the Initial stresses option from the Generate menu. The $K_0$-procedure dialog box appears.
- Keep the total multiplier for soil weight, $\Sigma M\text{weight}$, equal to 1.0. This means that the full weight of the soil is applied for the generation of initial stresses. Accept the default values of $K_0$ as suggested by PLAXIS and click on the <OK> button.

![Figure 3.9 Initial stress field in the geometry around the footing](image)

**Hints:**
- The $K_0$-procedure may only be used for horizontally layered geometries with a horizontal ground surface and, if applicable, a horizontal phreatic line. See the Reference Manual for more information on the $K_0$-procedure.
- The default value of $K_0$ is based on Jaky's formula: $K_0 = 1 - \sin \phi$. When the input value was changed, the default value can be regained by entering a negative value for $K_0$.

- After the generation of the initial stresses the Output window is opened in which the effective stresses are presented as principal stresses (see Fig. 3.9).
The length of the lines indicates the relative magnitude of the principal stresses and the orientation of the lines indicates the principal directions. Click on the <Update> button to return to the geometry configuration mode of the Input program.

After the generation of the initial stresses, the calculation can be defined. After clicking on the <Calculate> button, the user is asked to save the data on the hard disk. **Click on the <Yes> button.** The file requester now appears. Enter an appropriate file name and click on the <Save> button.

### 3.2.2 PERFORMING CALCULATIONS

After clicking on the <Calculate> button and saving the input data, the Input program is closed and the Calculations program is started. The Calculations program may be used to define and execute calculation phases. It can also be used to select calculated phases for which output results are to be viewed.

![Calculations window](image.png)

Figure 3.10 The *Calculations* window with the *General* tab sheet

The *Calculations* window consists of a menu, a toolbar, a set of tab sheets and a list of calculation phases, as indicated in Fig. 3.10.
The tab sheets (General, Parameters and Multipliers) are used to define a calculation phase. All defined calculation phases appear in the list at the lower part of the window.

When the Calculations program is started directly after the input of a new project, a first calculation phase is automatically inserted. In order to simulate the settlement of the footing in this analysis, a plastic calculation is required. PLAXIS has a convenient procedure for automatic load stepping, which is called Load Advancement. This procedure can be used for most practical applications. Within the plastic calculation, the prescribed displacements are activated to simulate the indentation of the footing. In order to define the calculation phase, follow these steps:

- In the General tab sheet, select Plastic from the first combo box of the Calculation type box and select Load adv. ultimate level from the second combo box.
- In the Phase box write (optionally) an appropriate name for the current calculation phase (for example “Indentation”) and select the phase from which the current phase should start (in this case the calculation can only start from phase 0 - Initial phase).
- Click on the <Parameters> button or click on the Parameters tab.

![Figure 3.11 The Calculations window with the Parameters tab sheet](image)
The Parameters tab sheet contains the calculation control parameters, as indicated in Fig. 3.11. Keep the default value for the maximum number of Additional steps (100) and select the Standard setting from the Iterative procedure box. See the Reference Manual for more information about the calculation control parameters.

- From the Loading input box, select Total multipliers.
- Click on the <Define> button or click on the Multipliers tab.

Figure 3.12  The Calculations window with the Multipliers tab sheet

- In the Multipliers tab sheet the level of the various load systems can be specified, as indicated in Fig. 3.12. The prescribed displacement is activated by means of the multiplier $S_{\text{disp}}$. Enter a value of 0.1. Because the input value of the prescribed displacement is 1.0 m downward, the result of the calculation will be a uniform settlement of $1.0 \times 0.1 = 0.1$ m.

**Hint:** The total level of a certain load system that is applied in a calculation phase is the product of the input value of that load system and the corresponding total multiplier.
The calculation definition is now complete. Before starting the first calculation it is advisable to select nodes or stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this, follow these steps:

- Click on the **Set points for curves** button on the toolbar. As a result, a window is opened, showing all the nodes in the finite element model.
- Select the node at the top left corner. The selected node will be indicated by 'A'. Click on the **Update** button to return to the Calculations window.
- In the **Calculations** window, click on the **Calculate** button. This will start the calculation process. All calculation phases that are selected for execution, as indicated by the blue arrow (→) (only one phase in this case) will, in principle, be executed in the order controlled by the **Start from phase** parameter.

![Figure 3.13 The calculations info window](image)

**Hint:** The **Calculate** button is only visible if a calculation phase that is selected for execution is focused in the list.
During the execution of a calculation a window appears which gives information about the progress of the actual calculation phase (see Fig. 3.13). The information, which is continuously updated, comprises a load-displacement curve, the level of the load systems (in terms of total multipliers) and the progress of the iteration process (iteration number, global error, plastic points, etc.). See the Reference Manual for more information about the calculations info window.

When a calculation ends, the list of calculation phases is updated and a message appears in the corresponding Log info memo box. The Log info memo box indicates whether or not the calculation has finished successfully. The current calculation should give the message 'No error'.

<table>
<thead>
<tr>
<th>Hint:</th>
<th>Calculation phases may be added, inserted or deleted using the &lt;Next&gt;, &lt;Insert&gt; and &lt;Delete&gt; buttons half way the Calculations window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Check the list of calculation phases carefully after each execution of a (series of) calculation(s). A successful calculation is indicated in the list with a green check mark (✓) whereas an unsuccessful calculation is indicated with a red cross (✗). Calculation phases that are selected for execution are indicated by a blue arrow (→).</td>
</tr>
<tr>
<td>&gt;</td>
<td>When a calculation phase is focused that is indicated by a green check mark or a red cross, the toolbar shows the &lt;Output&gt; button, which gives direct access to the Output program. When a calculation phase is focused that is indicated by a blue arrow, the toolbar shows the &lt;Calculate&gt; button.</td>
</tr>
</tbody>
</table>

In order to check the values of the multipliers that are reached at the end of the calculation, click on the Multipliers tab and select the Reached values radio button. In addition to the reached values of the multipliers in the two existing columns, additional information is presented at the left side of the window. For the current application the value of Force-Y is important. This value represents the total reaction force corresponding to the applied prescribed vertical displacement, which corresponds to the total force under 1.0 radian of the footing (note that the analysis is axisymmetric). In order to obtain the total footing force, the value of Force-y should be multiplied by $2\pi$ (this gives a value of about 1100 kN).

### 3.2.3 VIEWING OUTPUT RESULTS

Once the calculation has been completed, the results can be evaluated in the Output program. In the Output window you can view the displacements and stresses in the full geometry as well as in cross sections and in structural elements, if applicable.
The computational results are also available in tabulated form. To view the results of the footing analysis, follow these steps:

1. Click on the last calculation phase in the Calculations window. In addition, click on the <Output> button in the toolbar. As a result, the Output program is started, showing the deformed mesh (which is scaled to ensure that the deformations are visible) at the end of the selected calculation phase, with an indication of the maximum displacement (see Fig. 3.14).

2. Select Total displacements from the Deformations menu. The plot shows the total displacements of all nodes as arrows, with an indication of their relative magnitude.

![Deformed mesh](image)

**Figure 3.14 Deformed mesh**

3. The presentation combo box in the toolbar currently reads Arrows. Select Shadings from this combo box. The plot shows colour shadings of the total displacements. An index is presented with the displacement values at the colour boundaries.
Select Contours from the presentation combo box in the toolbar. The plot shows contour lines of the total displacements which are labelled. An index is presented with the displacement values corresponding to the labels.

**Hint:** In addition to the total displacements, the Deformations menu allows for the presentation of Incremental displacements. The incremental displacements are the displacements that occurred within one calculation step (in this case the final step). Incremental displacements may be helpful in visualising an eventual failure mechanism.

Select Effective stresses from the Stresses menu. The plot shows the effective stresses as principal stresses, with an indication of their direction and their relative magnitude (see Fig. 3.15).

**Hint:** The plots of stresses and displacements may be combined with geometrical features, as available in the Geometry menu.

![Figure 3.15 Principal stresses](image)

Click on the Table button on the toolbar. A new window is opened in which a table is presented, showing the values of the Cartesian stresses in each stress point of all elements.
3.3 FLEXIBLE FOOTING

The calculation is now modified so that the footing is modelled as a flexible plate. This enables the calculation of structural forces in the footing. The geometry used in this exercise is the same as the previous one, except that additional elements are used to model the footing. The calculation itself is based on the application of load rather than prescribed displacements. It is not necessary to create a new model; you can start from the previous model, modify it and store it under a different name. To perform this, follow these steps:

**Modifying the geometry**

- Click on the Go to Input button at the left hand side of the toolbar.
- Select the previous file (“lesson1” or whichever name it was given) from the Create/Open project window.
- Select the Save as option of the File menu. Enter a non-existing name for the current project file and click on the <Save> button.
- Select the geometry line on which the prescribed displacement was applied and press the <Del> key on the keyboard. Select Prescribed displacement from the Select items to delete window and click on the <Delete> button.
- Click on the Beam button in the toolbar.
- Move to position (0.0; 4.0) and press the left mouse button.
- Move to position (1.0; 4.0) and press the left mouse button, followed by the right mouse button to finish the drawing. A beam from point 3 to point 4 is created which simulates the flexible footing.

**Modifying the boundary conditions**

- Click on the Traction - load system A button in the toolbar.
- Click on point (0.0; 4.0) and then on point (1.0; 4.0).
- Press the right mouse button to finish the input of tractions. Use the default input value of the traction load (1.0 kN/m$^2$ perpendicular to the boundary).

**Adding material properties for the footing**

- Click on the Material sets button.
- Select Beams from the Set type combo box in the Material Sets window.
- Click on the <New> button. A new window appears where the properties of the footing can be entered.
- Write “Footing” in the Identification box and select the Elastic material type.
- Enter the properties as listed in Table 3.2.
- Click on the <OK> button. The new data set now appears in the tree view of the Material Sets window.
Drag the set "Footing" to the draw area and drop it on the footing. Note that the cursor changes shape to indicate that it is valid to drop the material set.

Close the database by clicking on the <OK> button.

Table 3.2. Material properties of the footing

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal stiffness</td>
<td>$EA$</td>
<td>$5 \cdot 10^6$</td>
<td>kN/m</td>
</tr>
<tr>
<td>Flexural rigidity</td>
<td>$EI$</td>
<td>8500</td>
<td>kNm²/m</td>
</tr>
<tr>
<td>Equivalent thickness</td>
<td>$d$</td>
<td>1.43</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>$w$</td>
<td>0.0</td>
<td>kN/m/m</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$\nu$</td>
<td>0.0</td>
<td>-</td>
</tr>
</tbody>
</table>

**Generating the mesh**

Click on the Mesh generation button to generate the finite element mesh. A warning appears, suggesting that the water pressures and initial stresses should be regenerated after regenerating the mesh. Press the <OK> button.

After viewing the mesh, click on the <Update> button.

**Initial conditions**

Back in the Geometry input mode, click on the <Initial conditions> button.

Since the current project does not involve pore pressures, proceed to the Geometry configuration mode by clicking on the 'switch' in the toolbar.

Click on the Generate initial stresses button, after which the $K_0$-procedure dialog box appears.

Keep $\Sigma M weight$ equal to 1.0 and accept the default value of $K_0$ for the single cluster.

*Hint:* If the Material Sets window is displayed over the footing and hides it, move the window to another position so that the footing is clearly visible.

*Hint:* Regeneration of the mesh results in a redistribution of nodes and stress points. In general, existing stresses will now correspond with the new position of the stress points. Therefore it is important to regenerate the initial water pressures and initial stresses after regeneration of the mesh.
• Click on the <OK> button to generate the initial stresses.
• After viewing the initial stresses, click on the <Update> button.
• Click on the <Calculate> button and confirm the saving of the current project.

Calculations
• In the General tab sheet, select for the Calculation type: Plastic, Load adv. ultimate level.
• Enter an appropriate name for the phase identification and accept 0 - initial phase as the phase to start from.
• In the Parameters tab sheet, accept all default settings (Loading input: Total multipliers).
• In the Multipliers tab sheet, enter a value of 350 for \( \Sigma \text{Load}_A \) (the multiplier for load system A). Note that this gives a total load that is approximately equal to the footing force that was obtained from the first part of this lesson.
• \( 350 \times 1.0 \text{ kN/m}^2 \times \pi \times (1.0 \text{ m})^2 = 1100 \text{ kN} \).
• Check the nodes and stress points for load-displacement curves to see if the proper points are still selected (the mesh has been regenerated so the nodes might have changed!).
• Click on the <Calculate> button to start the calculation.

Viewing the results
• After the calculation the results of the final calculation step can be viewed by clicking on the <Output> button. Select the plots that are of interest. The displacements and stresses should be similar to those obtained from the first part of the exercise.
• Double-click on the footing. A new window opens in which either the displacements or the bending moments of the footing may be plotted (depending on the type of plot in the first window).
• Note that the menu has changed. Select the various options from the Forces menu to view the forces in the footing.

Hint: Multiple (sub-)windows may be opened at the same time in the Output program. All windows appear in the list of the Window menu. PLAXIS obeys the Windows 95 standard for the presentation of sub-windows (Cascade, Tile, Minimize, Maximize, etc). See your Windows manual for a description of these standard possibilities.
Generating a load-displacement curve

In addition to the results of the final calculation step it is often useful to view a load-displacement curve. Therefore the fourth program in the PLAXIS package is used. In order to generate the load-displacement curve as given in Fig. 3.17, follow these steps:

- Click on the Go to curves program button on the toolbar. This causes the Curves program to start.
- Select New curve from the Create / Open curve dialog box.
- Select the file name of the latest footing project and click on the <Open> button.

A Curve generation window now appears, consisting of two columns (x-axis and y-axis), with multi select radio buttons and two combo boxes for each column. The combination of selections for each axis determines which quantity is plotted along the axis.

- For the X-axis select the Displacement radio button, from the Point combo box select A (0.00 / 4.00) and from the Type combo box -Uy. Hence, the quantity to be plotted on the x-axis is the vertical displacement of point A (i.e. the centre of the footing).
- For the Y-axis select the Multiplier radio button and from the Type combo box select ΣMloadA. Hence, the quantity to be plotted on the y-axis is the multiplier for the applied load.

Figure 3.16 Curve generation window
Click on the <OK> button to accept the input and generate the load-displacement curve. As a result the curve of Fig. 3.17 is plotted in the Curves window.

**Hints:** In order to re-enter the Curve generation window (in the case of a mistake, a desired regeneration or modification) you can click on the Change curve settings button from the toolbar. As a result the Curve settings window appears, on which you should click on the <Regenerate> button in the Miscellaneous box. Alternatively, you may open the Curve settings window by selecting the Curve option from the Format menu.

The Curve settings window may also be used to modify the attributes or presentation of a curve.

The Frame settings window may be used to modify the settings of the frame. This window can be opened by clicking on the Change frame settings button from the toolbar or selecting the Frame option from the Format menu.

---

**Figure 3.17** Load-displacement curve for the footing